Chief Architect®
Home Designer Suite® 2016

Reference Manual

Chief Architect, Inc.
6500 N. Mineral Dr.
Coeur d’Alene, Idaho 83815

www.HomeDesignerSoftware.com



© 19902015 by Chief Architect, Inc. All rights reserved.

No part of this book or the accompanying software may be reproduced or transmitted in any
form or by any means, electronic or mechanical, including photocopying, recording, or by any
information storage and retrieval system, without permission in writing from Chief Architect,
Inc.

Chief Architect® and Home Desi gner® are registered trademarks of Chief Architect, Inc.

This software uses the Ruby open source
This software uses the Freel mage open library. See http://www.ruby-lang.org/ for
source image library. See details.
http://freeimage.sourceforge.net for details.
Freelmage is used under the FIPL license,
version 1.0.

This application incorporates Teigha®
software pursuant to a license agreement
with Open Design Alliance.

Teigha® Copyright © 2003-2013 by Open
Design Alliance. All rights reserved.

All other trademarks and copyrights are the property of Chief Architect, Inc. or their respective
OWNers.

Created in the United States of America.


http://freeimage.sourceforge.net
http://www.ruby-lang.org/

Contents

Chapter 1: Program Overview

StaArtUP OPLIONS et 20
The Home Designer Suite Environment .............cccoeeevviinnnnes 21
USING the MOUSE ..o 23
View and Side WINAOWS .........cooiviiiiiiiiiiiiine e 25
Toolbars and HOtKeYS ..o, 26
MEBINUS ... 27
D F= 1 [ Yo 13 TSR 28
The Status Bar.......ccoocciiiiiiiiiiiiiiiiieeeeee e 30
MESSAGE BOXES ...oeeiiiiiie e 31
Preferences and Default Settings.........cooovvviiiiiiiiiiiciiiieneen. 31
Drawing aPlan ... 32
VIiewing YOUr Plan.........oooiiiiiiiiieiieeeeeeee e 33
Getting Help oo 34
About HOME DESIGNEN .....ccoieeeeeeeiieie e 35
Product Upgrade OptioNS .......ccccuviiiiiiiiiiiiiiieeee e 35
Home Designer Trial Software.........ccccceeeeiiiiiiiiiiiiiiiccieieee 35

Chapter 2: File Management

Compatibility with Other Programs............ooouiiiiiiiiininnnennn. 38
Organizing Your FileS.....cccoiiiiiiiii s 39
Home Designer Suite Data..........cccccuvvvimiiiiiiiiiieieeeeeeeeeeeeeee 39
Creating a New Plan ... 40



Home Designer Suite 2016 Reference Manual

Saving, Exporting, and Backing Up Files............cccccvviiieeneen. 41
Thumbnail Images ... 44
AULO ATCRIVE it 45
(8T To [0 T ] = 46
Opening and Importing Files ..., 46
Backup Entire Plan ... 48
Closing Views and FileS ... 48
Exiting Home Designer SUIte.........oooiviiiiiiiiiiiiiiiieee e 49

Chapter 3: Preferences and Default Settings

Default Settings vs Preferences.........ccccvviiiiiiiiiiciiiniiieeeeee, 52
Dynamic Defaults .........oouviiiiiiiiiii e 53
Reset to Defaults ......oooveveiiiiiiieie e 53
General Plan Defaults Dialog........cccuuuvviviiiiiiiiiieeeieeeeeeiiis 54
Preferences Dialog .........ouuuviiiiiiiiiiie e 55
Angle Style Dialog ......cooooiiiiiiii e 63

Chapter 4: Toolbars and Hotkeys

Chapter 5: Layers

Displaying ODJECTS ...ccoviiiiiiiiiiiiiee e 70
LAY @I SIS .ot 70
Display Options Dialog .....ccooevviiiiiiiiiiiiiiiiieeieeeeeee e 71

Chapter 6: Creating Objects
Architectural vS CAD ODJECTS......uuuviiiiiiiiiiiiiiiieee 74



SNAP BENAVIOIS ....uuiiiiiiiiiiiiiiieee 74

ODjJECT SNAPS i 74
ANGIE SNAPS .oviiiiiii e 75
Grid SNAPS .ttt 75
Creating ODJECTES ..ot 76
Copying and Pasting Objects........cccceeeeiiiiiiiiiiiccccee 77

Chapter 7: Editing Objects

Selecting ODBJECES ..o 82
Editing Line Based ODJECTS .......ccccuvvviiiiiiiiiiiiieieeeeeeeeeeeeee 84
Editing Arc Based ODJeCtS ........cceiiiiiiiiiiiiiee e 86
Editing Open Polyline Based Objects.........ccccevvvvivviiiieenennnn. 89
Editing Closed-Polyline Based Objects.......cccccccvvvvvciiinnnnnn. 92
Editing Box-Based ODJeCtS........coovviiiiiiiiiiiiiiieeiiii 94
Editing Spline Based ObjecCtS .......ccccceeeeeeeiiiieieeeee e 96
Editing Circles, Ovals and EllipSes ........uvvvvvviiiiiiiiiinn. 98
Displaying ODjJeCTS......ccoiiiiiiiiiiiiicre e 100
MOVING ODJECES ... 101
AlIgNING ODJECTS ..cooiiiii e 103
ResiziNng ODJECES ..o 104
Reshaping ODbJects ... 105
ROtating ODJECES ..ccooiiieiiiiiii e 106
Matching Properties ........oooevveiiiiiiiiiiiiiieee e 107
Deleting ObjJeCtS....ccoii i 108
UNdOo and REAO ....coooeeiiiiiiieeeeees e 109

Chapter 8: Walls, Railings, and Fencing

Wall DefauUItS ..uuueeiiiiie e 112
Wall TOOIS couiiii e 112
Railing and Deck TOOIS ......ccovvviiiiiiiiiiiii e 113



Home Designer Suite 2016 Reference Manual

FENCING TOOIS oo 115
Exterior and Interior Walls .........ccoooeiiiiiiiiiiiin, 115
Foundation WallS.........coooeiiiiiiiiiiiieeeeeeee e 116
Room Dividers and Invisible Walls ............ccoevvvviiiiicicnnnn. 116
Polygon Shaped DecKsS ..........uuuiiiiiiiiiiiiii, 117
HatCh Wall .......ooeiiiiiiiii e 118
Break Wall ... 118
Drawing WallS ... 119
Connecting WallS......ccooiiiiiiiiiiieeeeeiee e 120
Displaying WallS ... 121
Measuring Walls ... 122
Editing Walls ... 123
Editing Straight/Curved Wall Combinations ...................... 126
ANGNING WalS ..o 126
Roof Directives in Walls...........ooooiiiiiiiiiiiiiiiie e 127
ATLIC WIS oo 128
Wall Type Definitions .......ooovviiiiiiiiiiiieeeeeeeeeeeeeei 129
Wall Specification Dialog .........cceeeeviiiiiiieeiiiiiiieeen, 130
Railing and Fencing Specification Dialogs ......ccccccceeeeennn. 134
Wall Hatch Specification Dialog ........ooeeeeeiiiiiiiiiiiiiiinn 137

Chapter 9: Rooms

Floor and Room DefaultS .........ccceeviiiiiiiiiiiiiii, 140
RooOM Definition ........oooviiicccee e 140
Selecting ROOMS .....uiiiiiiiiiiiiiee e 141
Displaying ROOMS .....ooiiiiiiiiiiiiiiir e 142
Editing ROOMS ..o 142
ROOM TYPES .. 143
ROOM LabelS ..o 145
D= Tod 147



Floor and Ceiling Heights ... 147

Stepped Floor and Ceiling Platforms.........cccceeevvieiiiinninnne. 149
Special CeIliNGS .cooviiiieeeee e 149
Room Specification Dialog ........ccccvvvviiiiiiiiiiiiiieiieeeeeees 151

Chapter 10: Doors

DOOr DefaultS ..ccooeeee e 157
The DOOT TOOIS i 158
Displaying DOOIS .....ccoooiiiiiiieeeie e 160
EditiNg DOOIS ..ooiiiiiiiiiieeeeee et 161
Changing DOOI SWINQS ...uuuuuiiiiiiiieeeee et 162
SPECIAI DOOIS ..ot 165
Door Specification Dialog .......ccccuvivriiiiiiiiiiieeeeeeee e 166

Chapter 11: Windows

WiNndow DefaultsS ......ccoooeeiiiiiiieeen e 174
The WIiNdOW TOOIS ... 174
Special WINAOWS.......cooviviiiiiiiiiiii e 176
Grouped WINUOWS ....ueeieiiiiiiiieeeeeeeee e 177
Displaying WINAOWS ........cooviiiiiiiiiiiiiiiineee e 178
Editing WINAOWS ......ccooiiiiiiiieiie e 179
Window Specification Dialog ..., 180
Bay, Box, and Bow WINAOWS ..........uciiiiiiniiieiiiiiieieeeeiiiiiiiies 188
Bay, Box, Bow Windows and RoOOfS...........ccccevvvviiivininnnnnn. 190
Bay/Box and Bow Window Specification Dialogs ............. 192

Chapter 12: Multiple Floors

Floor Defaults Dialog.........coooiiiiiiiiiiiiiiieieeeeeeeeee e 196
FIOOT TOOIS oo 196



Home Designer Suite 2016 Reference Manual

AddiNg FIOOIS ..o 197
Displaying FIOOIS ....cooooiiiiiiiiie e 198
Deleting FIOOrS ..o 198
SPHE LEVEIS ... 199
The Current FlOOr ..o 200
The AttIC FIOOF wovveeiiii e 201
The Reference FIOOr ... 201

Chapter 13: Foundations

Foundation DefaultS ..........uuuuiiiiiiiiiiieeeee 204
Building a Foundation ..............ceoiiiiiniiiieeeeeeeen 204
Displaying FOuNdationS ..........cccceeeiiiiiiiieeecceeeeeeeee, 205
Editing FOUNdationsS .......cooooiiiiiiiiiieeeeeee e 206
Deleting FOUuNdationNS ........ouvvviiiiiiiiiien e 207
Foundations and ROOMS.........coooviiiiiiiiiiiiiiiiieeeeeeeeeee e 207
Foundations and the Terrain ..........ccccceeeiiiiiiieieiiiiiicceen, 208
FIrEPIACES ..o 210
Fireplace Specification Dialog.........cccceeeeeeiiviiiiiiiiiiiccn, 211
Library FIreplaces. ..o 213
CRIMNEYS .. 213

Chapter 14: Roofs

ROOf Defaults ...cooeueiiee e, 216
The ROOT TOOIS.....uiiiiiiiee e 216
AUTOMALiC ROOTS c.uuiiiiiiiiei e 217
Build ROOT Dialog......coeeiiiiiiiiiiiiee e 217
Editing ROOTS ..o 219
Gable Over Door/WIiNdOW ........ccccvviieeeeiiiiiiie e, 220
SKYHGNES e 220
Skylight Specification Dialog .........c.uvvveiiiiiiiiiieeeeeeeeeeeeeiin, 221



0] 88 111 =TT 223

Editing AUtO DOIMErS ....ccciiiiiiiiiiiiiiiiiee e 224
Dormer Specification Dialog........cccceeeeiiiiieieeeieeieeeieeiiiiin 224
Roof Returns and Other DetailS .......cccccceeeeeeeiiiiiiiiiiiiiiiiinns 226
ROOf Pitches iN DeQrees.........uuuuvuuiiiiiiiiiieeeeeeeee e 227

Chapter 15: Stairs and Landings

Stair DefaultS ... 229
The Stair TOOIS ..o 230
Anatomy Of & SEAIFCASE ........uuvvviiiiiiiiiiiiieee e 230
Drawing StailS ...coooei i 231
.......................................... Displaying Stairs and Landings233
EdItiNg STAIIS ..coeeiiiiiiiieeee e 233
Merging Stair SECHIONS .....ccovviiiiiiiiiiiiiie e 234
= T Lo 11 o Yo 1SRRI 236
Maintaining Tread Depth ..........ccccoiiiiiiiiiiiee 239
Starter TreaUS . ...couuuieiiiceiie e 239
Wrapped StaAIrS.......uuuuiieiiiiieeee e e e e e e e e 240
Other Special Railings and Stairs ..........cccccccviiiiiiiiiieeeeneenn. 241
Creating a Stairwell ... 242
ROOMS BElOW StaIrCases ......cccccuvviviiiiiiiiiiiiiiiiiee e e 243
Staircase Specification Dialog...........ooooeiiiiiiiiiiiiiieeeeeeen 244
Stair Landing Specification Dialog...........cceviiiiiiiiiniinnninnee. 250

Chapter 16: Electrical

The Electrical TOOIS ...coiiiiiiiii e 254
AULO Place OULIELS ...t 255
Creating Wiring SchematiCs .........cccccvvviiiiiiiiieiieeeeeee 256
Electrical Library Content ..........ccccceeeiiiiiiiiiiiiiiiiiiiiis 256

Displaying Electrical ObjectS......ccccceeeiiiiiiiiiiiiiiiiieeiiii 257



Home Designer Suite 2016 Reference Manual

Editing Electrical ObjJects ..o 257
Electrical Service Specification Dialog........ccccvvvvvvvvennnnnnn. 258

Chapter 17: Trim Tools

Trim and Molding DefaultS...........ouuuiiiiiiiiiiieeeeie 262
COrNEr BOArAS ..ottt 262
Corner Board Specification Dialog ...........ccooccivviviviiiieennnn. 263
QUOINS Lo e 263
Quoin Specification Dialog .........ccevvvevvviiiiiiiiiie e, 264
Editing Corner Boards and QUOINS..........uuuiiiiiiiiiiiiiiienennnnn. 264
IMITIWOTK e 265

Chapter 18: Cabinets

Cabinet Defaults ......ccoooiiiiii e 268
The Cabinet TOOIS ... 268
Cabinet FIllers ... 270
Placing CabinetsS.........oooiiiiiiiiiiiiiiie e 271
Displaying Cabinets ..........ccciiiiiiiiiiee e 272
Editing Cabinets ... 273
Editing Cabinet StylesS ... 273
Special CabinNetS . .....cciiiiiii e 275
Cabinet Specification Dialog ........cceeeeeeeiiiiiiiiiiiiiie 277
Shelf/Partition Specification Dialog .........cccceeeeeiiiiiiiiiiiinnnns 282

Chapter 19: Terrain

10

Terrain PeriMeter ..., 285
Elevation Data TOOIS .....coeeeiiviiiiiiieeeeic e 287
Terrain Modifier TOOIS ....oocvviiiiiiieee e, 290
Terrain Feature TOOIS ....coooviiiiiiieee e, 291



Garden Bed TOOIS ... 292

Water Feature TOOIS ... 293
Stepping StoNe TOOIS ...ovvvvvieiiiii e 294
Terrain Wall and Curb Tools ... 294
Terrain Objects in the Library ..o, 295
Displaying TerraiN.........cooovvviiiiiiiiiiiie e eeeeeee e 295
Editing Terrain ODJECTS ......ccoooiiiiiiiiieeeeeeee e 296
Terrain Specification Dialog ........coovvviiiiiiiiiiiiiii e, 297
Elevation Point Specification Dialog...........ccccvvvvvvvviiiinnnnn. 299
Elevation Line/Region Specification Dialog....................... 300
Hill / Valley Specification Dialog..........ccceeeeeiiiiiiiiiiiiiiiiiiiens 300
Raised / Lowered Region Specification Dialog.................. 301
Terrain Feature Specification Dialog ............ooooeiiiiiiinnnnee. 301
Garden Bed Specification Dialog ........coeuvvviiiiiiiiiiiiiiinineee, 305
Terrain Path Specification Dialog........ccccceeeeiiiiiiiieeeeennnne, 305
Importing Elevation Data.............cccciiiiiiiiiiiiiiiii 307
Import Terrain ASSIStaNT .....coooviiiiiiiiiiie s 307
Import GPS Data Assistant ..........ccccceeeeiieeiiieeeieececeeiiiii 309

Chapter 20: Roads, Driveways and Sidewalks

Road, Driveway and Sidewalk TooIS...........ccccevvvviiiiiiinnnnn. 314
Displaying Road ODjJecCts.........cccccuiiiiiiiiiiiiiieeeee 315
Editing Road ODjJeCtS.......cooviiiiiiiiiiiiiii e 315
Road Specification Dialog.........cccceveiiiiiiieieeeeeeeeeeeeeeeiiii 316

Chapter 21: Plants and Sprinklers

Plant TOOIS ..o 320
Plant Chooser DIialog.........ooooiiiiiiiiiiiiiiiiieeeeeeeee e 320
Hardin@SS ZONES ....oneee e 322

Plant Image Specification Dialog ..........ccceeeeeeeviviiiiiiiiiiinnnne, 323



Home Designer Suite 2016 Reference Manual

Chapter 22: Other Objects

General SNAPES ...vuuviiiiii i 327
SOTTITS c i 327
Special Applications for SOffitS.........ccceeeiiiiiiiiii, 328
Soffit Specification Dialog .........ooovveviiiiiiiiiiiiieeeeeeeeee, 330

Chapter 23: Architectural Blocks

Displaying Architectural BIOCKS...........ccccooviiiiiiiiiiiin, 334
Editing Architectural BIOCKS...........ccccuviiiiiiiiiiiiieee 334
Architectural Blocks and Sub-Objects .........cccevviiiiiiinnn. 334

Chapter 24: The Library

The Library BroWSer ... 338
Searching the Library.........cccconrii, 341
Library CONTENT ... 342
Downloading Library Content ...........ccceeeeiiiiiiiiiiiiiiiiinn, 344
Importing Library CatalogsS.....ccceeeveeeeiiieeeiiiiieeeeeen, 345
Adding Library Content..........cccccuviiiiiiiiiiiiiieeee e 346
Organizing the Library ... 347
Exporting Library CatalogsS.....cccceeeveeeiiiieeiiiiiiieeeeen, 350
Placing Library ODJECTS ......ooooiiiiiiiiiiiieeee e 350
Select Library Object Dialog........ccuvuvviieiiiiiiiiiieeeieiiieeeeeeeiee 352
Displaying Library ObjectS ......ccccevvieiiiiiiiiiiiiieeeeen, 352
Editing Library ODJeCTS .....ccooviiiiiiiiiiiieeeeeeee e 353
Symbol Object Specification Dialogs ........cccceeeeeeiviiiiiiiinnnes 354

Chapter 25: Materials
ADbOUL MaterialS.......cooveiiiiii e 357

12



Material DefaUltS ....c.oeeeeei e e 358

The Material Painter........ccoooo oo 359
Materials Panel ... 362
Select Material Dialog ......ccoovvvieieiiiiiiiiiee 363
Editing Materials ... 364
Creating MaterialS.........veiiiiiiiiee e 365
Define Material Dialog ..........ooooiiiiiiiiiiiiiieeeeeeeeee e 366
Select Color DIialog ...ueeeeeieniieeeeeeeeeeeeeee e 368

Chapter 26: Window and View Tools

VIEW TOOIS it 372
ZOOM TOOIS s 372
[0 To [o 7o T ¢ 4 IFS R UUPRPUR 373
FIll WINQOW i 373
Panning the Display.......cccovvveviiiiiiiiiie e 373
Working in Multiple VIEWS.........eeviiiiiiiiiiiiiiie 374
ClOSING VIBWS ... i 376

Chapter 27: 3D Views

OpenGL and Hardware ... 378
Backdrop Dialog ......coooeeiiiiieieee e 378
3D VIEW TOOIS i e e 379
Creating Camera VIEWS ........uuciiiiiiiieeeeeeeeeeeeeeee e 379
Creating OVEINVIEWS ......cuvviiiiiiiiiiiieeeeeeeeeeeeeeeeeee e 380
Elevation VIEWS ... 381
Displaying 3D VIEWS .....cccciiiiiiiiiiiiiiiiiiiaee e e e e e eeeeeeeeeeeenaaanes 382
Repositioning Cameras.............uvviiiiiiieeeeeeeeeeeeeeeeeeveaeaanaaans 384
Editing 3D VIEWS .ccoiiiiiiiiiiii ittt 387
Cross Section SHAr ......ouuvuiiiiiiiiiee e 389

WOTKING IN 3D .ciiiiiiiiiiiiee e a e e 390



Home Designer Suite 2016 Reference Manual

Saving and Printing 3D VIEWS .......ccoooiiiiiiiiiiiiiiieeeee 392
Camera Specification Dialog ........ccuuvvvveiiiiiiiiiiieeiiiiieeeeieiiies 393

Chapter 28: 3D Rendering

ReNdering TIPS oo 395
LIghting coveeeiiee e 397
Displaying LightS ... 398
Default Sun Light Specification Dialog........cccccevvvvvvvinnnnnnn. 398
Rendering TeChNIQUES .........uvvviiiiiiieii e 399
Speeding up 3D View Generation ...........oeeeevvivvvviiniinenennn. 400

Chapter 29: Dimensions

Dimension Unit Defaults .......cccoooeiiiiiiiiiiie, 403
Dimension Defaults Dialog .......ccooeviienieiieiiiiiiiceeeein, 403
The DIMension TOOIS ..o 406
Displaying DImension LIiNES..........ccccvviiiiiiiiiiiiiiiiiieeeeeeeen 408
Editing DIMeNSIioN LiNES......uuuiiiiiiiieeeeeeeeeeeeeeeeei s 409
Editing EXtension LiNeS .........cciiiiiiiiiiiieeeeeeeee, 411
Moving Objects Using DIMENSIONS.........uuuviiiiiiiiiiiiiieeeeeennn. 412
Dimension Line Specification Dialog.........ccccvvvvivivininnnnnnn. 414

Chapter 30: Text

14

TeXt Defaults ... 415
Fonts and Alphabets ..., 416
The TeXt TOOIS v 417
Creating TeXt. ... i e e eeeeaneees 417
Displaying TeXt ....cooiiiiiiieeeerrr e 418
Rich Text Specification Dialog ........ccccuvvviiiiiiiiiiiiiiiiieeeeee, 418
Text Specification Dialog .......ccceevveiiiiiiiiiiiiieee e 421



EdItiNG TOXE oo 422

Copying and Pasting TeXt......cccovveeiiiiiiiiieeceeeee e, 423
TEXE ATTOWS oottt e e e e e et e e e e e e eees 424
TeXt StYIES .. 425
Object Labels ... 428

Chapter 31: CAD Objects

The CAD Drawing TOOIS ..coooee i 431
Line Specification Dialog ..........cvvuviiiiiiiiiieeeeeeeieeeeeeeieiii 433
Arc Specification Dialog..........uuvvviieiiiiiiiiiiiiii e 435
CAD Circle/Oval/Ellipse Specification Dialog ............c....... 437
POIYIINES o 437
Polyline Specification Dialog........ccccuveiiiiiiiiiiiiiiiiieeeeens 438
Box Specification Dialog..........uuvvuiiiiiiiiiieeieieeeeeeeeeeeiieiiiiiies 440
SPIINES e ———— 440
Displaying CAD ODJECES ......cccoiiiiiiiiiiieieee e 442

Chapter 32: Project Planning

SPACE PlanNing ....uuueeiieiiiiiiiiiiieeeee e 443
Room Box Specification Dialog......ccccoovveeieeiiiiiiiiiiiiiiiiiiienns 445
Plan CRECK . ....uuiiiiiiiiiiic e 446
Loan CalCulator........oooiiiiiiiieeeece e 448

Chapter 33: Pictures, Images, and Walkthroughs

Picture Files vs Pictures and Image Objects ..................... 450
IM GG S ... 450
Displaying IMages .......ccoovviiiiiiiiiiiiieie e 451
Editing IMAQJES ...oooiiiiiiiieii e 452



Home Designer Suite 2016 Reference Manual

o] LU T 454
Picture File Box Specification Dialog ........ccccevvvvvvvuiiiinnnnn. 455
MELATITIES ...t 455
Metafile Box Specification Dialog ........cccevvvviiiieieiiiiiiinennnnn. 456
PDF FIlES ..ttt 457
PDF Box Specification Dialog ..........oeooeeeviiiiiiiiiiin, 458
Displaying Pictures, Metafiles, and PDF Boxes................. 458
Editing Pictures, Metafiles, and PDF BoOXes.........ccccccceennn. 458
Copy Region as PIiCtUre .........oovvvvviviiiiicccieee e 459
3D BaCKAIOPS ittt 460
WalKthroughsS ... 462
Walkthrough Path Specification Dialog.........ccccccccvvvvvnnnnnnn. 465

Chapter 34: Importing and Exporting

Import Room Planner File ..o, 470
D) 1= o o T 1 = | 470
Exporting 2D DXF FIl€S .....ouuuviiiiiiiiiiieeeeeee 470
Additional 2D Export Information .............ccooevvvvviiiiiiceennn. 471
3D Data Import Requirements .........cccooeveeeieiiciiiiiiiiieeeeee 472
Importing 3D SymboOIS.......oouiiii 473
3D Symbols and Materials ..........ccccccvvviiiiiiiieee e, 474

Chapter 35: Printing

16

Introduction to Printing.........ccceeeeiiiiin e, 478
The Printing TOOIS ... 479
Drawing Sheet Setup DialOog.....ccccovveeeiiiiiiiiiiiiiiiieeii, 479
PrINT PreVIEW ...vviiiiiiiiiiiieieeee e 481
Printing to SCaAle ...coovvviiiiiiii i 481
Printing Across Multiple Pages.........ccccoeeiiiiiiiiiiiiiiiinn, 482
Printing to a PDF File c.cooovvviiceieeee e, 483



Print View Dialog.......ccoooiiiiiiiiiiiiiiiie e 483
Print Image Dialog ......coooiiiiiiiiiiice e 486
Print MOGEl ...ooooviiiiiiii e 487
Chapter 36: Materials Lists

The Materials List TOOIS ....uuviiiiiiiiiiiiiiiiieeeiiee, 492
Creating an Accurate MaterialS LiSt.........cccccccvvviiiieininnnnnnns 493
Structural Member Reporting .......ccovveviiiiiiiiiiiiiieeeeeeeeeeeee 493
Organizing Materials LiStS ........cccooviiiiiiiiiiccciieie e, 494
Materials List Display Options Dialog......cccccccevveeeeiininnnnnns 495
Editing Materials LiStS......cooeiiiiiiiiiiiiiiiee e 496
Printing and Exporting the Materials List..........ccccceovvnnnene. 497
Conditioned Area TotalS ......cceeiiiiiiiiieeeeeeee e 497
Appendix A: Additional Resources

Reference Manual ...........oooovviiiiiiiiiiiii e 499
USEI'S GUITE ... 499
Online Help VIdEOS .....uuuuiiiiiiiii e, 500
Home Designer Web Site .......ccccciiiiiiiiiiiiiiiieeeeeeeeee e 500
Online Home Designer Samples Gallery .........cccceeeeiiineeee. 500
HomeTalk Online User FOrum .......ccccovvvevieiiiiiiinnneeeeeeiinnenns 500
Technical SUPPOTt.....cccoiiii e 501
Appendix B: Technical Support Services

Reference and Training RESOUICES........cccvvvviieeiiiiiiiiiiins 503
Troubleshooting Common Technical Issues ..................... 504
Troubleshooting Printing Problems.........ccccooeeeiiii, 504
Error MESSAgEeS ......oo i 506
Contacting Technical SUPPOIt.....ccoooiiiiiiiii e 507

17



Home Designer Suite 2016 Reference Manual

Program Paths Dialog ......ccooovviiiiiiiiiiiiiiiieeeeeeeee e

18



Chapter 1:

Program Overview

Home Designer Suite is designed to help
home enthusiasts visualize, develop and
share their design ideas. Home Designer
Suite uses parametric design technology,
which meansthat asyou draw, a3D model is
created and is updated as you make changes.
You can tile afloor plan view next to a 3D
view and watch one update automatically as
you draw in the other.

Chapter Contents
Startup Options
The Home Designer Suite Environment
Using the Mouse
View and Side Windows
Toolbars and Hotkeys
Menus
Dialogs
The Status Bar
Message Boxes
Preferences and Default Settings
Drawing aPlan
Viewing Your Plan
Getting Help
About Home Designer
Home Designer Trial Software

19
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Startup Options
. When Home Designer Suite opens, The Startup Options dialog can be opened at
=l the Startup Options dialog displays, any time by selecting File> Sartup
allowl ng you tq choose how you want to Options 2.
begin working in the program or access
useful resources.

Welcome to Home Designer

Chief Architect® Software

Home Designer. Suite

Resources ©

©- Recent Files

MY ACCOUNT @ —o

o Select aFile command to open a.plan « Choose Open Plan [] towork onan
file. existing plan file. See * Opening and
Importing Files’ on page 46.
g Recent Fileslists the full pathnames of
the most recently opened files. Click on
aname to open thefile.

« Click New Plan [} to open anew, blank
plan. See“ Creating a New Plan” on page

40.
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~~Move your mouse pointer over a name
@ to see the file’s full pathname.

A selection of useful online Resources

is available here. Select one to launch
your default internet browser to a page on
our web site, www.HomeDesignerSoft-
ware.com.

* Select Overview Video to watch a
browsable collection of videos outlining
the software's features and uses.

» Select Training Videosto access a
searchable collection of videos focused
on specific topics.

» Select Download Catalogs to visit our
3D Library of downloadable bonus and
manufacturer library catalogs. See
“Library Content” on page 342.

The Home Designer Suite Environment

a Click Getting Sarted to launch your

default internet browser to the Getting
Started page on our web site. There, you will
find links to avariety of online resources to
help you begin using the program.

6 Click My Account to launch your
default internet browser to the Log In
page on our web site.

Your software version’s Build humber
and thefirst five characters of your
Product Key display herefor reference.

To prevent the Startup Options dialog from
displaying when you launch Home Designer
Suite, uncheck Show Optionson Sartup in
the Preferences dialog. See” General Panel”
on page 58.

Object-Based Design

Home Designer Suite's parametric, object-
based design technology means you place
and edit objects, rather than work with the
many individual lines or surfaces used to
represent them.

You can quickly select and edit the location,
size, shape, style and other properties of
objects as well as change the materials
applied to their surfaces.

Use Home Designer Suite's editing
capabilities to make the objects you placein
aplan match the objects they represent in
real life. For example, you can set up your
windows and doors to match those available
from your supplier.

The Home Designer Suite Environment

3D Drafting

In Home Designer Suite, the entire drawing
areaislaid out on a Cartesian grid, athree
dimensional coordinate system described
using the X, Y, and Z axes. The current
position of your mouse pointer displaysin
the Status Bar at the bottom of the program
window.

Architectural objects take up spacein all
three dimensions and their height, width and
depth can be specified in Imperial or metric
units. In addition, the location of objects can
be precisely defined using coordinates, again
specified in Imperia or metric units.

CAD objects such as lines and arcs take up
space in two dimensions in the current view.
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Their dimensions can also be specified in
Imperial or metric units and their locations
precisely defined using coordinates.

Easy Access to Tools

You can access Home Designer Suite's
featuresin various ways using the mouse and
keyboard.

¢ Menus provide access to most tools.

Convenient toolbar buttons allow fast
access to tools and let you customize the
interface.

K eyboard shortcuts are available for most
tools.

Contextual menus display with aright-
click of the mouse.

The Status Bar at the bottom of the screen
provides tool descriptions and other
information about the current task.

Title —»| Home Designer 2016 - oIlEN
Ba_r File Edit Build Terrain Library 30 CAD Tools View Window Help
ADOEssclli? aa IROE 1A MmN %0
Menus CEM+EHABSE M= - MES O T %
X Uniitled 1: Floor Plan X | Library Browser 8 x
Parent il ' i Q -
| B Home Designer Core Catalogs

TOOIS D:[] . Home Designer Bonus Catalogs

I-H] I8 Manufacturer Catalogs

@ I User Catalog

§| W Trash L| br ary
Tool / = Browser
Palette =2 T 1 =

v Library
= o @ Preview
Selected B24R /s
Obj ect & o s |
5
r
cThoraryy '

Dimension

Edit
Toolbar

Interface Toggles

A number of useful drawing and editing
behaviors, aswell asthe display of important
elementsin the interface, can be easily
enabled and disabled using the menus. For
example:
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dore W1 won g X 11 [ B e T0
Base cabinet /

Pointer  Crosshair
Lines

, | Qb EEEP

bjects Floo X 244 7/16", ¥: 98 7/8", L: 35" \55:‘2 x413

Reference
Grid Lines

Satus Bar

Object Snaps, Angle Snaps, and Grid
Snaps can be toggled on or off as needed.
| See“Snap Behaviors’ on page 74.

Display Elementslike Print Preview,
Show Line Weights, and the Reference



Display can be turned on when needed
and then toggled off.

When a setting is turned on, itsicon in the
menu will display asmall checkmark at its
lower right corner and have a border around
itin.

Using the Mouse

Object Shaps is disabled

I'F ObjectSnaps  Shift+F11

| Angle Snaps F10
o~ Angle Shapsiis enabled

Many of these interface elements are global
Preferences while others are file-specific
default settings. See “Default Settings vs
Preferences’ on page 52.

Using the Mouse

Many objects, such asdoors and cabinets, are
created by clicking the left mouse button.
Others, such aswalls, stairs and dimension
lines, are created by dragging the pointer
from one end of the object to the other.

( Theleft button isthe primary
e button used in Home Designer
W  Suite. Unless specified otherwise,
Home Designer Suite
documentation refersto the left mouse
button.

Note: If you are left-handed and have re-pro-
grammed your mouse, reverse the instruc-
tions for left and right buttons in this manual.

( The Right button has several uses.
{*\i—/ Right-click to select any object.

If, for example, the Sraight Exterior

Wall [& tool is active, the left mouse button
allowsyou to select only walls. You can
select other object types such as cabinets
with the right mouse button.

You can also use the right mouse button to
open a context sensitive menu with
additional editing commands.

( The Middle button can be used to
o= paninfloor plan view. To close a
N tabbed view window, click onitstab

using the middle mouse button. You
can also program it to work as a double-
click.

If your mouse does not have amiddle mouse
button, in the Mac version of Home Designer
Suite you can use the left button and the
Command key to achieve the same results.

( The Mouse Wheel can be used to
$= zOOm in and out in most view types.
See“Zoom Tools” on page 372.

Using a Trackpad

In addition to the standard trackpad gestures
on your system, in Home Designer Suiteyou
can pinch to zoom.

In OS X 10.10 (Yosemite), use the click-hold
gestureto pan; in 10.9 (Mavericks) and prior,
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click-hold and two finger panning are
supported. Panning is not supported in the
Windows version of the software, however.

Edit Handles

When you select an object, its edit handles
display.

When you pass the mouse over an edit
handle, information about what the handle
does displays in the Status Bar and the

pointer changes to show how you can use
that handle.

¢ A two-headed arrow indicates that the
object, corner or edge can be moved in
the direction of the arrows.

* A four-headed arrow indicates that the
selected object or edge may be moved in
multiple directions.

¢ A circular arrow indicates that the
selected object can be rotated.

Resize handles display along the edges of the
object are used to change the size. See
“Resizing Objects’ on page 104.

The Move handle at the object’s center lets
you move the object. See “Moving Objects”
on page 101.

Thetriangular Rotate handle lets you rotate
the object. See “Rotating Objects’ on page
106.

Y )
-]
e

You can cancel any edit handle operation
before it is completed by pressing the Esc
key on your keyboard or by pressing any two
mouse buttons at the same time.

The edit handles that display depend on the
type of object selected, the current view, and
how far you are zoomed out.

Edit handles do not resize as you zoom in or
out. If you are zoomed out far enough, some
edit handles may be hidden so that they do
not stack over one another. Asyou zoom in,
these handles become visible again.

Mouse Pointer Icons

The appearance of the mouse pointer in
Home Designer Suite will vary, depending
on which tool is active. For example, when

the Select Objects || tool isactive, it will
look like awhite arrow, and when a Cabinet

Tool isactive, it will look like a base
cabinet with asmall cross.

In addition, one or more additional icons
may follow the mouse pointer if Angle Snaps
isnot inuse or if a problematic condition
existsin thefile:

Icon Setting
| Angle Snaps

A Fix Wall Connections




View and Side Windows

View and Side Windows

Home Designer Suite’s main program
window has a number of important features
that let you interact with the program, such
as toolbars and menus. It aso features two
different kinds of windows:. view windows
and side windows.

View Windows

View windows are sometimes referred to as
“the drawing area’ because most of them are
windows in which you can draw or place
architectural and/or CAD objects. There are
anumber of different types of view windows
in Home Designer Suite:

* Floor plan view

» Cameraviews and overviews
» Elevation views

* MateriasLists

View windows can be navigated by panning
and zooming; and, they have scroll barson
the right side and on the bottom. You can
turn off the display of the scroll bars by
selecting View> Scrollbars . See*View
Tools’ on page 372.

Although only one view window can be
active at any given time, thereisno limit to
the number of view windows that can be
open. View windows can betiled or tabbed,
and you can navigate between themin a
number of different ways. See “Window and
View Tools’ on page 371.

You can a'so tear aview window out of the
main program window. This creates a
second, separate program window complete
with toolbars and menus. Individual view

windows can be torn out and transferred
between program windows.

Side Windows

Side windows provide access to avariety of
tools and content that helps you add detail
your drawings.

Side windows are so-named because they are
typically docked to either the left or right
side of the program window - although, they
can also be docked to the top or bottom, or
undocked entirely. There are several
different types of side window:

e Child Tool Palette
e ThelLibrary Browser

Each of these side windows can be opened
viathe View menu or by clicking the toolbar
button associated with it. Similarly, each can
be closed by clicking the Close button in its
title bar or tab, viathe View menu, or by
clicking itstoolbar button. See “View Tools’
on page 372.

To undock a side window, either drag itstitle
bar out into the drawing area or click the
Undock button on itstitle bar. To dock aside
window, drag itstitle bar to any side of the
program window. You can also double-click
on itstitle bar to return it to its last docked
location.

Two or more side windows can be docked
together to form a shared side window, and
can be tiled and/or tabbed within that shared
window. To create a shared side window,
begin by docking a side window to a side of
the main program window, then:
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¢ To create tabbed side windows, drag a
second side window over the first. When
the docked window becomes highlighted,
rel ease the mouse button.

e To create tiled side windows, drag a sec-
ond sidewindow over thefirst. When the
docked window becomes highlighted,
slowly drag the mouse towards one of its

sides. When a highlighted spaceis cre-
ated along that side, release the mouse
button.

You can choose to disable Side Window
Drag Docking in the Preferences dialog,
and you can also enable Top/Bottom
Docking See “ Appearance Panel” on page
56.

Toolbars and Hotkeys
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Using the toolbar buttons is the fastest,
easiest way to access many program features.
If atool isactive, asmall checkmark will
display at the lower |eft of its buttonicon.
When you pass the pointer over atoolbar
button, a“tool tip” displays the name of the
tool and amore detailed description displays
in the Status Bar at the bottom of the
program window. When you see one of these
tool tips, pressthe F1 key to get more
information about that item. See “Getting
Help” on page 34.

Home Designer Suite'stools are organized
into families of related tools which can be
accessed using either of two styles of toolbar
interface: the Child Tool Paette or Drop
Down tools. You can select the interface that
you prefer in the Preferences dialog. See

“ Appearance Panel” on page 56.

The Edit Toolbar

When you select an object, the edit toolbar
appears. By default, it islocated at the
bottom of the program window, just above
the Status Bar. The buttons on the edit

toolbar can be used to edit the selected
object(s). Which buttons display depends on
the type of object selected, the current view,
and how you selected the object.

ot o X L 64 T T (Y

The edit toolbar buttons are the same as the
options in the contextual menu when you
right-click on an object. See “ Contextual
Menus’ on page 27.

Hotkeys

Many commands can be invoked from the
keyboard. Press Alt on your keyboard and
press the underlined letter in amenu name to
access that menu, as well asitemsin the
menus and submenus.

Other keysor key combinationswill invoke a
variety of program commands. If aHome
Designer Suite menu item has a keyboard
shortcut, or hotkey, associated with it, that
hotkey will display to theright of itsnamein
the menu.



Menus

Menus

Home Designer Suite uses a standard
Windows menu format. The menus are
located below the title bar in the program
window and can be used to access nearly all
toolsin the program. Click on a menu name
to expand it, then click on amenu item to
either activate that tool or accessthe item’s
submenu. Items with a submenu have an
arrow to the right of the name.

Menu items with an icon to their left have a
toolbar button associated with them.

The menus can be accessed using the
keyboard. Pressthe Alt key once to enable
this functionality - one letter in each menu
will become underlined. Press the key
associated with one of these underlined
letters to expand its menu - one letter in each
menu item’s name will be underlined. Press
the key associated with one of these |ettersto
activate that tool or accesstheitem’s
submenu. Pressthe Esc key to undo your last
selection, or click with the mouse to exit out
of this functionality.

Many toolsin Home Designer Suite also
have hotkeys associated with them. If amenu
item has a hotkey, it will display to the right
of the item’s name. See “Hotkeys’ on page
67.

Edit | Build Terrain  Library 3D CAD
7 Undeo Ctrl+Z
Cx Redo Ctrl+Y

Edit menu items with button icons
to the left and hotkeys to the right

In the Home Designer Suite documentation,
menu paths are written in thisformat: Build>

Window> Box Window ¥V,

Contextual Menus

Contextual menus are context-sensitive
menus that display toolsrelevant to a
selected object or view. To open a contextual
menu, right-click on an object, in an empty
spaceinaview window, or in atext fieldina
dialog box.

The options in an object’s contextual menu
are usually the same as those on an object’s
Edit toolbar. See “The Edit Toolbar” on page
26.

% Select
nest  Select Mext Object Tab
M Open Object Ctrl+E

=0 Copy/Paste
E;' Copy and Paste in Place

Ctrl+Alt+C

X Delete Del
f+ AddtoLibrary
¢ Center Object Ctrl+G

ﬁ Change Opening/Hinge Side
=<¢)= Change Swing Side

[E‘ Show Door Open in 3D
Gable Over Door/Window

Contextual menus can be enabled or disabled
in the Preferences dialog. When contextual
menus are disabled, right-clicks perform
generic object selection, much like when the

Select Objects | & tool isactive See
“ Appearance Panel” on page 56.
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Dialogs
Default and preference settings, object

specifications, display settings, and many
other functions are accessed through dialog

boxes.

Many dialogs have multiple panels, which
arelisted in atreelist on the left side of the
dialog. Click on apanel nameinthelist to
make it active. In Windows, panels can also

be navigated using the keyboard. Press:

e Ctrl + Tab or Ctrl + F6 to navigate for-

ward;

e Ctrl + Shift + Tab or Ctrl + Shift + F6 to

navigate backward.

When apanel nameis active, you can also
navigate the tree list using the Up and Down

arrow keys.

By default, dialogs always open to the first
panel inthelist; if you prefer, you can choose
to Open Dialogsto the Last Panel Visited.

See “Genera Panel” on page 58,

Dialog panels and settings can be accessed
using the mouse. You can aso navigate the
settings on agiven dialog panel using the

keyboard. For example:

e Lineitemsin treelists can be browsed
using the arrow keys. Up and Down navi-
gatethelist, while Left and Right expand

and contract categories.

¢ Pressthe Tab key to shift focus from the
treelist to thefirst setting on the selected

panel.

e Pressthe Tab key to shift focus from one
setting to the next, or Shift + Tabtogoin

the reverse direction.
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A checkbox can be checked or cleared by
pressing the Spacebar or the + or - keys,
respectively, whileit isin focus.

Columns of radio buttons can be navi-
gated using the Up and Down arrow
keys, rows can be navigated using the
Left and Right arrows. Select aradio but-
ton by pressing the Spacebar whileitisin
focus.

Settingsin list boxes can be navigated
using the Up and Down arrow keys.
When a checkbox isin focus, it can be
checked or cleared by pressing the Space-
bar.

Drop-down lists can be browsed using
the Up and Down arrow keys. When the
mouse pointer is directly over the drop-
down, the mouse scroll wheel can also be
used; on aMac, the list must also be
expanded. In Windows only, you can
press Tab to select the highlighted item in
the list and proceed to the next setting.

Settings with spin control arrows v can
be adjusted by typing in the text field or
using the Up and Down arrow keys.
When the mouse pointer is directly over
the setting, the mouse scroll wheel can
also be used.

Slider bars —J~ can be adjusted by typ-
ing in the text field or using the L eft and
Right arrow keys. When the mouse
pointer is directly over the dider bar, the
mouse scroll wheel can also be used.

Lineitemsin tables can be group selected
using the Ctrl or Shift keys, or by press-
ing Ctrl+A.



» Press Enter on your keyboard to close
most dialogs and apply your changes.

Note: Keyboard navigation in dialogs may
vary somewhat depending on your computer
platform.

In the Mac version of the software, Dictation
is supported in dialogs. Select Edit> Sart
Dictation, then open adialog. Say the word
“Numeral” before a number to enter it asa
numeric value or immediately follow a
number with a unit such as “foot” to enter it
as a measurement.

The units of measurement used in dialogs are
determined by your choice of template files.
See “Creating a New Plan” on page 40.

The number format used in dialogs are set
based on your operating system’s defaults.

Dialog Size and Position

Dialog boxes can be both moved and resized
to suit your needs. By default, the program
will remember both the position and size that
you specify for adialog and use it the next
time you open it. You can specify whether
the program does this always, per session, or
never in the Preferences dialog. You can
also reset the default sizes and positions. See
“Reset Options Panel” on page 62.

» Tomove adialog, position your mouse
pointer withinitstitle bar and then simply
click and drag.

» Toresizeadialog, position your mouse
pointer on any edge or corner and then
click and drag outward or inward. If you
drag an edge, only that edge will move; if
you drag a corner, the two adjacent edges
will move.

Dialogs

When adialog is resized, some elements
within it may resizein response: for
example, some list boxes and text fields.
Some elements within adialog box can aso
be resized independently. See “Dialog Panel
Splitters’ on page 30.

Note that all dialogs have a minimum size
limitation but no maximum size. If adiaog
opens on amonitor with resol ution too low to
display itsfull extents, it will have vertical
and/or horizontal scroll bars.

Note: Some of the dialog box images in the
software documentation have been resized
smaller than their actual minimum size.

Specification Dialogs

I—l Each object in Home Designer Suite
has a unique specification dialog
where you can enter size, style and other
information specific to the selected object.
To accessiit, select the object and click the
Open Object edit button. You can also
double-click on an object with the Select

Objects | &/ tool active to open its
specification dialog. See*” Selecting Objects’
on page 82.

Most objects also have a defaults dialog that
lets you specify theinitial valuesin the
specification dialog.

Dialog Preview Panes

Many specification dialogs have a preview
pane that shows how changes affect the
selected object. This preview updates when
you click in adifferent field or pressthe Tab
key on your keyboard.
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When you click in the preview pane, your
mouse pointer changes to a four-headed
arrow and you can rotate around the object as
well aszoom in and out using the mouse
scroll wheel. Some objects, notably walls,
doors, and windows, have Interior and
Exterior labelsto indicate which sideis
visible in the preview. Click the Fill

Window [ button above the preview pane
to zoom in or out so that the object fills the
extents of the pane, maintaining the current
rotation.

A selection of Rendering Techniques can be
applied to the preview in most dialogs:
Standard, and Glass House. See “Rendering
Techniques’ on page 399.Click the

Color ™ button to turn color in the preview
off or on. Some objects have additional tools
that affect object previews. For example, the

Cabinet Specification dialogs have a Select

Cabinet Face Item |78 button. Object
specific tools like this are discussed in the
documentation for that object type.

Dialog Panel Splitters

Many dialog panels are divided into up to
three sections: alist of panels on the left, an
object preview on theright, and a central
area where settings are located. The vertical
splitters separating these sections each have a
pale, dotted handle.

To resize the panel list or preview, aswell as
the areain the middle, move your mouse
pointer over the vertical division line: when

the splitter cursor b can be seen, click and
drag to the left or right.

The Status Bar
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The Status Bar at the bottom of the main
program window displays information about
the current state of the program.

This information depends on a variety of
conditions such as the type of object
selected, and the current position of the
pointer. The information may include the
following:

e Thetype of object currently selected or
the total number of group-selected
objects.

» A description of the edit handle that the
pointer is over.

e A brief description of the toolbar button
or menu item highlighted by the mouse.

* The name of the active tool.

The length and/or angle of an object asiit
is being drawn.

Basic information about aselected library
object, folder, or catalog.

* Thecurrent floor.
» Thesize of the active window in pixels.



Message Boxes

Message Boxes

Asyou work in Home Designer Suite, the
program will occasionally prompt you to
examine your settings, alert you if you
command it to do something that could
potentially cause a problem, or notify you if
it encounters a problem that needs your
attention

N Information

.'6] Area too constricted, could not position fixture item here,

["] Do not show this message again

Check Knowledge Base

Situations where such message boxes may
display include:
» Closing afile without saving;

* Modifying an object that is set to rebuild
automatically;

» A filereferenced outside the program,
such as an image or texture, is missing;

» Creating an object in a space too small to
contain it.

Aswith dialog boxes, you can access the
options in a message box using the mouse or
navigate them using the keyboard.

A few messages have a Send Report button.
Click this button to anonymously send
details regarding the issue that prompted the
message to Chief Architect viathe internet.

Some message boxes include a“ Remember
my choice” or a“Do not show this again”
checkbox. Check this box to prevent
messages of this specific type from
displaying in the future. When thisbox is
checked, some options in the message box
may becomeinactive.

To allow all message boxesto display again,
click the Reset M essage Boxes button in the
Preferences dialog. See “Reset Options
Panel” on page 62.

Preferences and Default Settings

Preferences and default settings control
many aspects of the user interface and tool
behavior in Home Designer Suite. You can
use these settings to customize the program
to suit your personal work style.

For more information about defaults and
preferences, see “ Preferences and Default
Settings’ on page 51.

Preferences

Preference settings let you change program
behavior to suit your workflow. For example,
you can:

e Turn certain display elements on or off.

» Choose background and editing feedback
colors.

»  Set rendering specifications to maximize
efficiency and quality.
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Preference settings are global, affecting all
plan files.

Defaults

Most objects in Home Designer Suite derive
their intial properties from their respective
default dialogs.

For example, anewly placed Window =
getsitsinitial values from the Window
Defaults dialog and a newly placed Hinged

Door {\ getsitsinitial valuesfrom the Door
Defaults dialog.

Once an object is placed in aplan, itsinitial
properties can be overridden, but setting up

your defaults before you begin drawing can
save you considerable time as you build a
model in the program.

Default settings, unlike Preferences, arefile
specific.

Dynamic Defaults

Most default settings are static: if you change
one, any objects of that type in the current
filewill not be affected. A few defaults,
however, are dynamic: they aretied to
existing objects in the drawing and if you
change the default, those objects may be
affected. See “Dynamic Defaults’ on page
53.

Drawing a Plan
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When you draw a plan in Home Designer
Suite, you are placing 3D objects that
represent building components. Home
Designer Suite comes with predefined
default settings so you can start drawing
plansimmediately. You should review these
default settings to be sure they match your
drawing and building methods. See
“Preferences and Default Settings’ on page
51.

Set the Defaults

Specify the defaults for walls.

Set material defaults for roof, walls, and
rooms.

3. Set style defaults for doors, windows,
cabinets and other objects.

Draw the Floors

1. Whilethe size of the drawing areain
Home Designer Suiteislimited only by
the resources on your compuiter, it isbest
to begin your drawing near the origin,
0,0,0. See“ 3D Drafting” on page 21.

2. Draw the exterior wallson Floor 1. See
“Drawing Walls" on page 119.

3. Adjust the perimeter shape and size as
required. See “Using the Edit Handles’
on page 123.

4. Place any first floor bearing walls.

5. Definetypesfor special rooms such as
garages and decks in the plan. See
“Room Types’ on page 143.

6. Place perimeter doors and windows. See
“Doors’ on page 157 and “Windows’ on
page 173.



7. Build additiona floors. See “Adding
Floors’ on page 197.

8. Specify the default ceiling height for
each floor as soon asit is created. See
“Foor Defaults Dialog” on page 196.

9. Adjust the perimeter shape of additional
floors as needed. See“Editing Walls’ on
page 123.

10. Align edited or moved walls with those
above or below where appropriate. See
“Aligning Walls’ on page 126.

Entering Dimensions

When using Imperial units, enter distances as
inches or feet and inches, in fractional or
decimal form. Millimeters are the default
unit for all metric distances. See “Dimen-
sions’ on page 403.

» To enter feet, include the () marker or
the program assumes inches.

e Inmost cases, the program allows
precision to 1/16th of an inch. Fractions
with denominators 2, 4, 8 and 16 are
allowed.

» The program usually converts decimals
to fractions.

Viewing Your Plan

Build the Foundation

1. Derivethefoundation plan from the first
floor. See “Building a Foundation” on
page 204.

2. Adjust the foundation perimeter shape
as needed.

3. Placeinterior foundation walls as
needed for the first floor bearing walls.

4. Place any other foundation walls
required.

5. Align with Above as needed. See
“Aligning Walls” on page 126.

Add Structure and Details

1. Build non-structural interior walls.
Begin on floor one and work up in mul-
tiple story structures.

2. Addwallswhere needed to create fea-
tures such as chimney chases, plumbing
walls, or Open Below areas.

3. Finishtherelevant interior structure
including interior doors, doorways, cabi-
nets, fixtures, and fireplaces.

4. Build theterrain and landscaping. See
“Terrain” on page 285.

Viewing Your Plan

You can see your model in avariety of
different 2D and 3D views. You can display
more than one view at atime; and in any
view, you can pan or zoom in or out. See
“Window and View Tools” on page 371.

Floor plan view isa 2D view of the model and
is most commonly used for drawing and

editing. In floor plan view, each floor displays
separately and you can only edit onefloor at a
time; however, you have extensive control
over which objects display at any given time,
can easily switch between floors, and can also
display items on a second floor for reference.
See “Multiple Floors” on page 195.
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You can aso create Doll House Views that
show only the current floor plus any floors
beneath it. Ceilings on the current floor are
omitted so you can see the interior, visualize
the relationships between spaces, and plan
traffic flow.

You can create interior and exterior 3D views ~ Framing Overviews display framing in 3D.
of your model from any perspective. Asin You can customize 3D views to serve special
floor plan view, you can select and edit many purposes such as this.

objectsin 3D views and control which objects
arevisible. See“3D Views’ on page 377.

All views can be exported as a graphic
image. See “To export apicture’ on page

454,
Getting Help
7 There are many forms of help assumes you are familiar with basic
= | availablein Home Designer Suite computer terminology.

including: Tool Tips, the Status Bar, and the

. More information is available in the product
online Help menu.

documentation in electronic format and on
All these forms of help assume you have a Home Designer’s official web site,

basic working knowledge of your operating www.HomeDesigner Software.com.
system, including how to use a mouse, open, “ . ,

close and save files, copy, paste, and right- See “Additional Resources’ on page 499.
click to access contextual menus. Help also
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Tool Tips

When you move the pointer over atoolbar
button or menu item, a Tool Tip displays,
offering a brief description of the tool. More
information displays in the Status Bar at the
bottom of the window.

Contextual Help

.-? OnlineHelp isasearchable menu that
= | providesinformation about all of the
toolsin Home Designer Suite. Select Help>
Launch Help to open the program’s Help
and explore the table of contents, browse the
Index, or Search for keywords.

The Help can aso be used to provide instant
information about toolbar buttons, menu
items, and objects in your plan.

About Home Designer

«  When you move the cursor over atoolbar
button or menu item, a brief summary of
that tool displaysin the Status Bar. Press
the F1 key to open online Help to a page
with more information about the tool.

» When an object is selected, edit handles
display. Place the cursor over an edit han-
dleand press F1to openonline Helpto a
page with information about that handle.

» Pressthe Help button in any dialog box
to open online Help to a page describing
the options in that dialog.

Chief Architect strives to make our docu-
mentation as helpful as possible for all of
our customers. Please send any questions,
comments, or feedback to
documentation@chiefarchitect.com.

About Home Designer

Select Help> About Home Designer Suite
in Windows® or Home Desi gner > About

Home Designer in Mac OS X® to view
information about your software license, the

program’s version number, and its release
date.

Contact information for Chief Architect, Inc.
is available on the M ore | nfor mation panel.

Product Upgrade Options

Select Help> Product Upgrade Optionsto
launch your default web browser to the
Home Designer web page,

www.homedesi gnersoftware.com, whereyou
can learn about options for upgrading your
software license.

Home Designer Trial Software

Free Trial versions of some Home Designer
programs are available for download at
www.HomeDesigner Software.com.

The Tria software offers the same
functionality as a purchased license with a
few limitations:
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¢ File Saving

e Printing

e File Exporting

¢ Recording of Walkthroughs

e Printing or Exporting of Materials Lists
e Library Browser restrictions

Converting the Trial Version

Aninstallation of the Home Designer Suite
Trial software can be converted into afull
working version of the program at any time
by purchasing a software license. There are
several ways to begin this processin the
Trid:
¢ Click the Purchase Full Version Now
button in any Trial Restriction message
box.

Select Help> Purchase Home Designer
Suite ¥ .
Select File> Sartup Options E= and

then click the Purchase Full Version
Now button.

Once you have purchased alicense, you can
activate it while the Trial softwareisrunning.

To activate the full version

1.

Select Help> Activate Full Version.

Inthe Product Activation dialog, type
or paste the Product K ey associated
with your software license.

Click the Activate Full Version button.



Chapter 2:

File Management

Home Designer Suite saves the complete 3D
model of a structure and surrounding terrain
aswell as any CAD data associated with the
model in .plan files.

All commands related to opening, saving and
closing plans are located in the File menu.
You can a'so open plans from the Startup
Options dialog. See“ Startup Options’ on
page 20.

Just aswith files created in other software

applications, you should back up your plan
files externally on aregular basisto avoid

accidental loss of work.

Chapter Contents
Compatibility with Other Programs
Organizing Your Files
Home Designer Suite Data
Creating aNew Plan
Saving, Exporting, and Backing Up Files
Thumbnail Images
Auto Archive
Undo Files
Opening and Importing Files
Backup Entire Plan
Closing Views and Files
Exiting Home Designer Suite
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Plans produced in the following programs
can al beread by Home Designer Suite
2016.

« Chief Architect® X1 through X6 (limited
editability if enabled)

« Chief Architect® 5.0 through 10.08 (read
only)

« 3D Home Architect® 3.0 and 4.0

« Chief Architect® Home Edition 5.0
¢ All Better Homes and Gardens Home

Desi gner® products, Interior Designer,
and Landscaping and Deck Designer, Ver-
sions 6 through 8.

« All Chief Architect Home Designer®
products, Interior Designer, and Land-
scaping and Deck Designer, Versions 9
through 2015.

« Trading Spaces® Design Companion™

Note: 3D Home Architect 5.0 was not devel-
oped by Chief Architect, Inc. Plans written
using 3D Home Architect 5.0 or later cannot
be read by Home Designer Suite software.

Files that have been opened and saved in

Home Designer Suite 2016 cannot be read by
any of the program versions listed above. To
continueto read filesin the program in which
they were created, be sure to create copies of

your files before opening them in Home
Designer Suite 2016.

Plans produced in the Wi ndows® version of
Home Designer Suite 2016 can beread in the

Mac® version, and vice versa.

Opening Chief Architect Plans
in Home Designer Programs

Plans created in Chief Architect Versions5
through X6 and Home Designer Pro Versions
6 through 2015 can be opened in the latest
Home Designer programs for viewing and
annotating, but not for general editing or
drawing of architectural objects.

Plans created in Chief Architect, build 11.4
and later, and Home Designer Pro 2015 can
be set to allow limited editability in other
Home Designer programs. When this
permission is enabled, aHome Designer user
can use al of their program’s drawing tools
and can edit objects in the plan that those
tools can create. If an object cannot be
created in the Home Designer program,
however, it will not be editable.

In addition, Chief Architect and Home
Designer Pro have the ability to lock layers.
Objects cannot be drawn on locked layers,
objects on locked layers cannot be selected;
and locked layers cannot be unlocked in the
other Home Designer programs. See
“Layers’ on page 69.



Organizing Your Files

Organizing Your Files

You should keep your plan files separate
from the support files needed to run Home
Designer Suite. To keep files organized, you
may find it helpful to create a new folder for
each project.

Home Designer Suite files may use imported
images, textures and other custom content
saved in their own external datafiles.
Consider storing copies of all external filesin
the samefolder asthe plan filesthat use them
so that they are easily found.

Here is one way to organize your files:

» Create afolder in your Documents direc-
tory caled “Home Designer Suite Plans”
or another name you prefer. See your
operating system’s Help to learn how to
create folders.

* Inside thisfolder, make a new folder for
each project. Save al the filesfor that
project inside this folder, including plan
files and referenced external files. See
“Saving, Exporting, and Backing Up
Files’ on page 41.

Bear in mind, though, that path names
exceeding 260 characters cannot be opened
by Home Designer Suite. Asaresult, itisa
good idea to limit the number of embedded
foldersyou use in your file organization
method.

Once you understand the file management of
Home Designer Suite, you can decide on a
naming convention that suits your needs.

Home Designer Suite Data

When Home Designer Suite 2016 is
installed, the program automatically createsa
folder in the user Documents directory called
Home Designer Suite 2016 Data. This
folder containsimportant user-specific
information saved in the following folders
and files and should not be moved, renamed
or deleted:

» Archives- A folder of automatically
archived plan files. See “Auto Archive’
on page 45.

» Backdrops- A folder of custom back-
drop images. See “3D Backdrops’ on
page 383.

» Images- A folder of custom images. See
“Adding Materials and Images’ on page
346.

» Database Libraries- A folder of user
library data. See “Library Content” on
page 342.

e Scripts- A folder for custom Ruby
scripts associated with Chief Architect
plans.

» Templates- A folder of plan template
files. See “Creating a New Plan” on page
40.

e Textures- A folder where you can save
image files used to create custom material
textures. See “Creating Materials’ on
page 365.
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e Toolbars- A folder of toolbar files. See
“Toolbar Arrangement” on page 65.

If the Home Designer Sui